
PixView™

User ’s Guide

V e r s i o n  3 . 0

Pixel Translations
A Division of Input Software, Inc.

1710 Fortune Drive, Suite 200
San Jose, California  95131

Telephone (408) 325-3800
Fax (408) 232-9292

PTMN-00050-04 (9805 NYA)



PixView User’s Guide

ii

Cornerstone Imaging, Inc. makes no warranties, either expressed or implied, regarding the
enclosed computer software package, its merchantability, or its fitness for any particular
purpose, except as explicitly stated in any enclosed product warranty. The exclusion of
implied warranties is not permitted by some states. The above exclusion may not apply to
you. This warranty provides you with specific legal rights. There may be other rights that
you may have which vary from state to state.

PixView™ is a trademark of Pixel Translations.

All product names mentioned in this book are trademarked or copyrighted by their
respective owners.

© 1994 - 1998 Pixel Translations. All Rights Reserved. All information contained in this
document is proprietary to Pixel Translations. No part of this document may be copied,
photocopied, reproduced, translated, or reduced to any electronic medium or machine-
readable form without prior consent, in writing, from Pixel Translations. The software
described in this document is furnished under a license agreement.

This manual describes the installation and use of copyrighted software. Said software is
licensed to the End User for use only in strict accordance with the End User License
Agreement. Licensee is advised to read this End User License Agreement carefully before
commencing use of this product.

Important Notice

The product described in this manual is designed to store and process almost any document
or drawing available in printed form. Most printed materials are copyrighted under the laws
of the United States and other countries. It is illegal to copy or reproduce on disk or paper,
by use of this software or any other means, materials for which you or your company do not
have permission, unless your activity is within some of the limited exceptions to the
copyright laws. Copyright infringement carries with it serious civil and criminal penalties
under the law. Do NOT use this product to copy materials illegally.

Many scientific and professional journals give blanket permission to copy and reproduce
portions of their contents by transmitting a fee per page copied, usually specified in the
journal, to the Copyright Clearance Center, 27 Congress Street, Salem, MA  01970  USA, or
to the publisher. Consult your attorney or the copyright owner for specific information.
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1  Introduction

This manual explains how to install and use PixView, a high-performance Microsoft
Windows application for scanning, viewing, printing, and saving images.

About PixView

PixView is an image scanning application that supports more than 125 different scanners.*

PixView provides an integrated image acquisition environment that allows you to scan,
view, print, and store images.

Scanning PixView uses ISIS® (Image and Scanner Interface Specification) libraries to
support all popular monochrome, gray scale, and color scanners. ISIS drivers
enable scanning at the full rated speed of your scanner. For most scanners,
ScanAhead™ ensures that the next page’s image is always immediately
available. PixView allows full control of scanner parameters, allowing you to
adjust brightness, contrast, scan resolution, scan mode, dithering, color
settings, and any other settings available in your scanner. PixView supports
scanners that use dedicated controller cards, as well as SCSI scanners via
Adaptec and other compatible SCSI host adapters, and video-based scanner
interfaces, such as those from Kofax and Xionics. Duplex (double-sided)
scanning is supported on scanners that provide this feature.

Viewing PixView is also a high-performance image viewer that has many features for
displaying and manipulating images. Features include fast scaling (zoom in
and zoom out), fast rotation (in 90º increments), background preload (for
immediate display of images on demand), annotations, scale-to-gray
conversion (to improve readability of images displayed at less than full
scale), and a pan window (for instantaneous positioning of the image in the
view window). In addition, PixView fully supports imaging display hardware

                                                          

* PixView is sold with various levels of scanner permissions, depending on configuration.
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accelerators from Cornerstone. Color images can be displayed either in color
or gray scale, and color balance can be adjusted while viewing.

Printing PixView prints images using any standard Windows-supported printer.
Options for convenient image printing include Fit Page, Actual Pixels, Actual
Size, and Thumbnails. In addition, PixView supports accelerated printing
hardware from Fujitsu (Print Partner 10i) and Xionics (XIPPrint). Faxing of
images can be accomplished with any Windows-compatible fax modem and
software.

Saving PixView saves acquired images in a variety of popular image file formats and
compression schemes. By using TIFF Group 4, you can achieve compression
ratios of 35:1 to 50:1, depending on the type of image and the quality of the
scan. Color and gray scale capabilities vary according to your scanner and the
image file format in use. PixView supports color and gray scale file storage,
scanning, viewing, and printing. For a complete list of file formats and
compression schemes, see page 56.
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System Requirements

Following are the minimum system requirements for PixView:

Computer: 386SX or higher PC-compatible.

Memory: 4 Mbytes, minimum; 8 Mbytes recommended.

Diskette drive: 3.5” high density.

Mouse: Windows-compatible pointing device is required to operate
PixView.

Hard disk: The process of image acquisition and storage requires large
amounts of disk space, with the actual requirement depending on
the number of images you want to store, their type
(monochrome, gray scale, color), and compression. PixView
itself requires less than 5 Mbytes of disk space.

Display: VGA (minimum).

Operating system: 16-bit version: DOS 5.0 or higher running Microsoft
Windows 3.1 or higher.

32-bit version: Windows 95 or Windows NT.

Scanner (optional): A supported image scanner and suitable interface card.

Network: PixView runs in network environments as a single-user
application. It is recommended that PixView be installed on a
local drive. Users should be aware that saving large images to a
network drive may result in reduced network performance and
unacceptable application performance.

 Important

 If your computer uses a SCSI hard disk drive and you are using a SCSI
scanner, we recommend that you connect the scanner to a separate SCSI
host adapter from the hard disk. The reasons for this are: 1) there have
been cases reported of hard disk crashes apparently related to scanner
operation on the same SCSI host adapter, and 2) high-performance
scanners will almost certainly degrade system performance when sharing
the SCSI host adapter with a hard disk.
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Ordering Additional Scanner Drivers

PixView is supplied with and has permissions to use a subset of all ISIS scanner drivers.
Drivers are constantly being developed for new scanners, and many new scanners are
supplied with an ISIS driver that will work with PixView (provided your copy of PixView
has sufficient permissions to use that type of scanner). To obtain information on upgrading
PixView to work with additional scanners and information on the availability of other
drivers, contact the PixTools Sales department using the contact information listed in .
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2  Quick Start

This chapter is for computer users who are familiar with their computers and want to start
using PixView as quickly as possible. Chapter 3, “Installing PixView,” contains complete
installation and setup instructions for users who need detailed information.

Before installing PixView, check for a file named README.TXT on the PixView diskette.
If this file exists, then it contains new information that became available after this manual
was printed. You should display or print this file and read it carefully.

Installing a Scanner

Before installing PixView, you should install your scanner hardware and make sure it is
functioning properly. Be sure that the scanner interface card uses settings that do not
conflict with other devices in your system.

A SCSI driver is sometimes required for proper operation of a SCSI host adapter card.
Make sure you have the appropriate drivers loaded, as instructed by the manufacturer of
your SCSI host adapter.

Installing PixView

PixView is supplied on a CDROM. To install PixView, follow these steps:

1. Launch Windows and insert the PixView CDROM into your CDROM drive.

2. Windows 3.x: From Program Manager or File Manager, choose Run from the File
menu. Type e:\setup and click OK. Substitute the drive letter of your CDROM
drive if necessary.

 Windows 95/NT 4.x: The install program will launch automatically after the CDROM
is inserted.
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3. Follow the instructions on your screen to choose an installation directory, a program
group, and proceed with installation.

Starting PixView

Windows 3.x: Start PixView by double-clicking its icon in the PixTools Products Program
Group.

Windows 95/NT 4.x: Start PixView by choosing PixView from the PixTools Products
group on the Start menu.

The PixView window now appears. It looks similar to the following, depending on the
version of Windows being used, the window’s size, and PixView’s application settings:
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Selecting a Scanner

Before you can scan pages, you must select your scanner:

1. Choose Select Scanner from the File menu. The Scanner Selection dialog appears:

 

2. In the Scanner Selection dialog, scroll through the list of scanners until you find your
scanner, then click to highlight it.

 Note

 If a message appears stating that you do not have permission to use a
particular scanner, you have not purchased the correct level of PixView
for your scanner. For information about enabling other scanners, contact
the PixTools Sales department using the contact information listed in
Appendix C. For information about obtaining and adding support for
scanners not listed in the Scanner Selection dialog, see page 23.

3. Click OK. You are now ready to scan pages.

 Note

 All supplied ISIS scanner drivers have been copied to the
Windows\Pixtran directory of your hard disk.

Scanning Pages and Documents

To scan pages:

1. Place one or more pages in your scanner.
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2. Choose Scan Page from the File menu. In a moment, your scanner will scan and the
image of the first page will appear in the PixView window.

or

Choose Scan Batch to File from the File menu. A dialog appears prompting you to
supply document naming information. Complete this information and then click OK. In
a moment, your scanner will begin scanning and continue scanning at its full rated
speed until all pages in the feeder have been scanned.

 Note

 Some scanners do not report when pages are loaded in their automatic
document feeders. If your scanner falls into this category, then you will
see a dialog after choosing Scan Page in which you can specify whether a
page is on the flatbed or in the feeder.

3. To use other scanning features, see Chapter 4 “Using PixView” on page 25.

Viewing Pages

After you have scanned one or more pages, PixView offers many viewing possibilities. To
see a few of these, click the various buttons in the toolbar:

Enlarges or reduces the page until it fits the width of the PixView window.

Enlarges or reduces the page until it fits the width or height of the PixView
window, whichever is smaller, to ensure that you can see the entire page
image.

Displays one pixel on the screen for every pixel in the image.

Zooms in a user-defined amount.

Zooms out a user-defined amount.

Rotates the image 90º clockwise.
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Displays the previous page of a set of pages. Inactive when the first page is
currently being displayed.

Displays the next page of a set of pages. Inactive when the last page is
currently being displayed.

If you scale an image so that it is larger than the PixView window, you can use any of three
methods to move other parts of the image into view:

Scroll bars These are the Windows standard for moving around a document, but are
not very efficient when dealing with highly magnified image views.

Keyboard Use the cursor arrow keys as well as the HOME, END, PAGE UP, and PAGE

DOWN keys to move the image. This is also not very efficient.

Pan window Use the pan window to quickly and efficiently bring the desired portion of
the image into view. If the pan window is not visible, press P to enable it.

In addition to the toolbar buttons, you can change the appearance of the image in the
PixView window by using the Page Settings command in the Options menu. You can
experiment with these settings now. For more information, see “Changing Page Settings”
on page 72.



PixView User’s Guide

10

Printing Pages

To print your pages, make sure your printer is configured and selected in the Windows
Control Panel, and that it is on-line and ready to print. Then choose one of the following
commands from the File menu:

Print (Fit Page) Prints pages so that they fill the page. For full page images, this
may result in a reduction or enlargement to ensure that the entire
area is within the printable region of the printed page.

Print (Actual Pixels) Prints pages such that one pixel in the scanned image corresponds
to one pixel on the printed page.

Print (Actual Size) Prints pages actual size, with no scaling. Most printers have a
margin around the page where they cannot print. Image data in
this region is clipped. To ensure printing the entire image, choose
Print (Fit Page) instead.

Print (Thumbnails) Prompts for number of images per page and then prints multiple
tiny page images on each page.

In each case, you can specify the number of copies to print, the print quality, and the range
of pages to print. Optionally, you can print just a section of a page. To print a section, you
must drag a selection rectangle over the desired portion of the page image before choosing
the Print command, as explained on page 45.
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Saving Pages and Documents

With the exception of single-page scans, PixView saves your pages as you scan. Normally,
there is no need to perform a separate save operation. You will need to save individual
images scanned using the Scan Page command. You will need to save your document in
cases where you have opened a document and want to change its attributes, orientation, or
file type/compression.

You can save either individual pages or documents (sets of pages). Sets of pages can be
saved in a single file (if you are using an image file format that supports multiple pages) or
in multiple files (using any of several supplied or user-defined naming schemas). In
addition, you can save a selected area of a page or a selected area of  every page of a
document.

To save the page currently displayed, choose Save Page As from the File menu, choose a
drive and directory, file type, and compression, then type a name in the File Name box and
click OK.

To save a document (all pages), choose Save Document As from the File menu, chose a
drive and directory, file type, and compression, then type a name in the File Name box.
Next, choose Multi-page file and/or Use Naming Schema and click OK. For detailed
information on naming schema, see “Naming Schemas” on page 63.

To save a selection, first select an area of a page by using the mouse. Drag the mouse to
create a rectangle around the area you are interested in. Then choose either Save Page As or
Save Document As from the File menu. Note that “Selected area” is checked. Specify the
usual parameters and save the file—only the selected area of the page or the selected area
applied to every page of the entire document is saved.
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Shortcut Keys

Key Button Menu Command Effect

+ Zooms in an amount specified in the
Zoom Factor setting

- Zooms out an amount specified in
the Zoom Factor setting

B Changes Horizontal Preserve toward
Black. (black and white).

Increases the Brightness (grayscale).

CTRL+1 Rotate to portrait orientation (0º).

CTRL+2 Rotate to landscape orientation (90º).

CTRL+3 Rotate to upside-down portrait
orientation (180º).

CTRL+4 Rotate to upside-down landscape
orientation (270º).

CTRL+A Options♦ Application
Settings

Displays the Application Settings
dialog.

CTRL+B Changes Vertical Preserve toward
Black. (black and white).
Increases the Contrast (grayscale).

CTRL+C Edit♦Copy Copies the image or the selected
area to the Clipboard.

CTRL+E Options♦ Scanner
Settings

Displays the Scanner Settings
dialog.

CTRL+G Page♦Goto Page Displays the Goto Page dialog.
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Key Button Menu Command Effect

CTRL+I Help♦About Image Displays the About Image dialog,
which gives you information about
the image on the current page.

C Cancels scanning. Note that the
scanner may continue to scan one or
more pages before it receives and
processes the cancel command.

CTRL+M
or S

Options♦Page
Settings

Displays the Page Settings dialog.

CTRL+L Loop to next image. Unlike Next
Page and Prev Page, goes to first
page after displaying last page of
document.

CTRL+N Page♦Next Page Displays the next page of the
document.

CTRL+O File♦Open document Displays the Open Document dialog.

CTRL+P Page♦Previous Page Displays the previous page of the
document.

CTRL+R Demo♦Loop Images Loops through up to eight images as
fast as possible, then shows flip
times when stopped. (Demo version
only.)

CTRL+S Demo♦Stop Demo Stops loop demo and shows image
flip times. (Demo version only.)

CTRL+T Page♦Show
Thumbnails

Displays the Thumbnail viewer,
allowing you to select the page you
want to view.
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Key Button Menu Command Effect

CTRL+U Loop only once through images.
(Demo version only.) Allows display
of image read, decompress, and
display times. After looping once,
images may be cached; demo will
then show only display times.

CTRL+W Changes Vertical Preserve toward
White (black and white).
Decreases the Contrast (grayscale).

CTRL+Z
or P

Options♦Pan
Window

Toggles Pan window display on and
off.

F1 Help♦Index Displays the main index of the on-
line help system.

F2 Image is sized to fit the width and
height of the window

F3 Image is sized to fit the width of the
window.

F4 One pixel of the image is displayed
for each pixel in the display.

F5 or
CTRL + D

Demo♦Load Images Load the five demo images (demo
version only).

G Toggles between normal and scale to
gray display.

I Toggles display between positive
and negative image display.

M Toggles between normal and mirror
image display.

O Toggles the overscan (background
window) color between black and
white.
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Key Button Menu Command Effect

PAGE UP Scrolls up the page height of the
window.

PAGE

DOWN

Scrolls down the page the height of
the window.

HOME Scrolls to top of current page.

END Scrolls to bottom of current page.

N Returns to default image settings
after changing orientation, scaling,
brightness, contrast, etc.

W Changes Horizontal Preserve toward
White (black and white).

Decreases the Brightness
(grayscale).
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3  Installing PixView

This chapter provides complete installation and configuration instructions for PixView. If
you are experienced with Windows software installation, you may prefer to follow the quick
start instructions in Chapter 2.

Scanner Installation

The first step in installing PixView is to install your scanner. PixView can open images
created by virtually any popular scanner on the market; however, PixView is much more
convenient to use with a supported scanner. A supported scanner is one which can be
operated by PixView’s scanning controls. For an up-to-date list of scanners supported by
PixView, contact PixTools Sales department using the contact information in Appendix C.
This list can be accessed from the Internet at Pixel Translations' World-Wide Web site.

Install your scanner by following the manufacturer’s instructions. Be sure to remove all
packing material and shipping locks. Be sure that your scanner interface settings do not
conflict with other devices in your system. In particular, pay attention to the I/O address,
memory address, DMA channel, and/or SCSI ID, as needed by your particular scanner
interface. If possible, test your scanner using software provided by the manufacturer to be
sure it is working properly and communicating with your computer.
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Types of Scanners

There are many categories of scanners. Some of the types that are supported by PixView
include:

• Flatbed scanners
• Feeder scanners
• Flatbed scanners with document feeders
• Check scanners
• Microfilm scanners

• Duplex (double-sided) scanners
• Full page scanners

• Monochrome scanners
• Gray scale scanners
• Color scanners

Scanner Interfacing

Different scanners connect to computers by different methods:

Dedicated
interface card

Must be installed in your computer and connected using a cable provided
with the scanner.

SCSI host
adapter

In some cases, you can use a commercially-available SCSI host adapter.
In other cases, you must use a dedicated SCSI host adapter provided by
the scanner manufacturer. In either case, we recommend that you do not
use the same SCSI host adapter for your scanner and SCSI hard disk.

Video interface A few scanners use a special interface card that receives video data from
the scanner for high-speed image transfer. These special interface cards
are generally manufactured by a third party (Kofax and Xionics, for
example) and are connected to the scanner via special cables.

Parallel or
serial interface

A few scanners connect directly to your computer’s built-in parallel (or
even serial) interface. Acquiring images from a scanner connected to the
serial port will be a very slow process.
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Scanner Settings

Various scanners have different capabilities, and therefore different settings. PixView
supports whatever settings are available on your scanner. Typical settings include:

• Brightness (and automatic brightness)
• Contrast (and automatic contrast)
• Mode (black and white, gray scale, color)
• Dither (simulated halftoning)
• Dots per inch (scan resolution)
• Page size
• Outline extraction
• Gamma correction
• Thresholding
• White level
• Noise removal
• Scanning area

For information about changing these settings, see “Changing Scanner Settings” on page 71.
During installation, your scanner’s default settings should be adequate.

PixView Installation

This section provides step-by-step instructions for installing the PixView software. At any
time during the installation process, you may use the Back button to return to a previous
screen to change the options you selected. If you exit the installation program before it is
finished, you will need to rerun the program later.

Installing PixView

Follow these steps to install PixView on your hard disk:

1. Insert the PixView CDROM into your CDROM drive.

2. If you are using Windows 3.1, Windows for Workgroups 3.11, or Windows NT 3.5,
from the Windows Program Manager or File Manager, choose Run from the File
menu. In the Command Line box, type e:\setup. (Substitute e:\ for the drive letter
of your CDROM drive if necessary.) Click OK.
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 If you are using Windows 95 or Windows NT 4.0, the installation program will start
automatically after you insert the CDROM.

 When the installation process begins, follow the instructions on your screen.

3. You will be prompted for registration information including your name and company,
as well as a product serial number. You can find the serial number on the CDROM
packaging, or it was provided to you in conjunction with your download instructions.

4. You can choose to install PixView using Typical, Compact, or Custom setup options.
We recommend using the Typical installation option for most users. A Typical setup
provides the most commonly used PixView features and utilities that should suit your
day-to-day scanning and viewing needs.

A Typical installation includes:

• The main PixView application.

• Runtime files that are necessary auxiliary components for PixView to function
properly.

• Documentation on how to use PixTools products and general information about
those products.

• Helpful utilities including a program that will allow you to add additional scanner
drivers to your PixView installation later on.

• Sample images.

A Compact installation only adds the main PixView application and the necessary
Runtime files to your system. You should only consider this option if you are severely
limited in hard disk space.

A Custom installation allows you to choose which components of PixView to install.
The available components are the same as the ones listed under Typical installations.
You should only consider this option if you are an experienced user and wishes to have
more control over the installation process. At a minimum, you need to install the main
PixView application and the Runtime files for the software to function properly.

5. You will be asked to read and accept the PixView End User License Agreement. If you
do not accept the agreement, the installation program will terminate.

6. You can choose to install a scanner driver for your scanner, or any number of scanner
drivers that are supported with PixView. You will need to install at least one scanner
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driver if you wish to use PixView’s scanning features. You can also add additional
scanner drivers to your installation at a later date by using the AddScan utility.

7. Choose a destination folder where the PixView application and other components will
be installed. The default destination folder is c:\pixtran.

8. Choose a program folder where the program icons for PixView will be installed. The
default folder is "PixTools Products".

9. You will be asked to verify your choices and installation settings before files are copied
to your system.

10. After the files have been copied to your system, a dialog box will indicate that the
installation process completed successfully.

Installing Additional Scanner Drivers

Scanner drivers are normally installed during the regular installation process for PixView.
However, you may need to install additional scanner drivers if you did not do so when you
installed PixView, or if you wish to use PixView with a new scanning device. To install
additional scanner drivers using the AddScan utility, follow these steps:

1. Insert the PixView CDROM into your CDROM drive.

2. Choose Programs from the Start menu.

3. Go to the PixTools Products program folder or the program folder in which you chose
to install PixView.

4. Choose the Utilities folder.

5. Choose the Add Scanner icon to run the AddScan utility.

6. You will be prompted to choose your scanner from the list of supported scanners. Click
OK. The appropriate driver will be copied to your system.

7. You will receive a message informing you that the scanner driver was installed
successfully, or that you already have an updated driver in your system for the scanner
you selected.

8. You will now be able to select the new scanner from within PixView.
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Selecting a Scanner

The final step in installing PixView is to select your scanner. Follow these steps:

1. Turn on your scanner. (In most cases, you will need to turn on your scanner before
launching Windows; otherwise, Windows will not be aware that the scanner is
connected.)

2. Launch PixView by double-clicking the PixView icon.

 

3. Choose Select Scanner from the File menu. The following dialog appears:

 

 After all driver names have been loaded, the following dialog appears:

 

4. Choose your scanner from the list.
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 Important

 PixView is sold with various levels of scanner support. If your copy of
PixView does not have sufficient permissions to use a particular scanner,
it will not appear in the Scanner Selection dialog, even though its driver is
present on your disk drive. Contact PixTools Sales department using the
contact information in Appendix C for information about upgrading your
copy of PixView to support the scanner you want to use.

5. Click Setup to see your scanner’s setup parameters. These parameters vary depending
on your scanner. In some cases, there are no setup parameters, or setup parameters are
made in the DOS driver that loads in your CONFIG.SYS or AUTOEXEC.BAT file. In
these cases, the message “This scanner’s configuration is set using the system-level
driver” appears. Consult your scanner’s documentation for proper setup.

6. Click OK when you have made the desired settings.

Adding a Scanner Driver From Within PixView

We recommend that you use the AddScan utility provided with PixView to add new scanner
drivers. Some scanner drivers require support files to function properly. AddScan will
install all such necessary files for you automatically. For instructions on how to use
AddScan, see "Installing Additional Scanner Drivers" on page 21.

You can also add drivers from within PixView. However, only the driver itself is added to
your system. If you need to install support files for your scanner, you should use the
AddScan utility. Follow these steps to add a scanner driver from within PixView.

1. Choose Select Scanner from the File menu.

2. In the Scanner Selection dialog, click Add. The Add Scanner dialog appears.

 

3. Place your PixView CDROM into the CDROM drive.
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4. Change the drive letter in the Add Scanner dialog to read e:\drivers. Substitute e:
with the driver letter of your CDROM drive if necessary.

5. Click OK. A list of scanners found on the CDROM appears.

6. Select the desired scanner from the list, then click OK.

 Tip: For users of Kofax scanner interface cards, use the KFXSIMPLX driver for simplex
(single-sided) scanners; use the KOFAXBIC driver for duplex (double-sided) scanners.

7. Click Setup to see your scanner’s setup parameters. These parameters will vary
depending on your scanner. In some cases, there are no setup parameters, or setup
parameters are made in a DOS scanner driver that loads in your CONFIG.SYS or
AUTOEXEC.BAT file. In these cases, the message “This scanner’s configuration is set
using the system-level driver” appears. Consult your scanner’s documentation for
proper setup. Here is a typical Setup dialog for a popular SCSI scanner:

 

 Note that the specific information displayed in this dialog depends both on your scanner
and on the way it is configured.

8. Click OK when you have made the desired settings.

PixTools/View Control Panel

PixView is supplied with the PixTools/View control panel to display accelerated printing
and display. Information on installing and using this control panel can be found in
Appendix A.
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4  Using PixView

This chapter explains how to perform all types of scanning, viewing, printing, and saving
operations in PixView.

Starting PixView

To start PixView, follow these steps:

1. Turn on your scanner. Wait for your scanner to indicate that it is ready.

2. Start Microsoft Windows.

 Note

 In many cases, the scanner must be on before Windows starts; otherwise,
Windows will not be able to communicate with the scanner.

3. If you are using Windows 3.1, Windows for Workgroups 3.11, or Windows NT 3.5,
launch PixView by opening the PixTools Products Program Group (or the group you
specified when installing PixView) and double-clicking the PixView icon.

 

 If you are using Windows 95 or Windows/NT 4.0 or higher, launch PixView by
choosing PixView from the PixTools Products group on the Start menu (or the group
you specified when you installed PixView).



PixView User’s Guide

26

PixView Visual Index

Here is the PixView window after scanning a few pages, with page numbers showing where
in this manual you can find more information on each major feature:

 

Scanning Pages

PixView can acquire images either from a scanner or by opening existing image files. This
section explains how to scan. For information on opening existing image files, see “Opening
Documents” on page 36.

Rotating
(page 47)

Pan window
(page 48)

Scanner settings
(page 77)

Zooming
(page 46)

Next/Prev
(page 48)

Scroll bars
(page 48)

Scanning
(page 32)

Opening
documents

(page 43)

Selecting a
scanner

(page 26)

Annotation
Toolbar
(page 55)
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Scanning Batches

PixView is designed to scan batches of pages as quickly and efficiently as possible. When
scanning a batch of pages, you tell PixView in advance how to save the resulting file(s).
PixView saves each page to the specified file as it scans. Then, in the event of a power
failure, system crash, or other unexpected event, the pages you have already scanned are
saved and you can continue scanning where you left off.

To scan a batch of pages, follow these steps:

1. Choose Scan Batch to File from the File menu.

 Important

 When you choose Scan Batch to File, any open pages or documents are
closed. If you had previously acquired an image by using the Scan Page
command and have not saved it, the page image will be lost.

 The following dialog appears after you choose Scan Batch to File:

 

2. Choose:
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a. An image file format from the List Files of Type list box (see page 56).
b. A color format from the Color Format list box (see page 58).
c. A compression option from the Compression list box (see page 56).
d. An orientation in the Save Orientation list box (see page 63).

3. Decide whether to:

a. Have PixView warn you if you specify an existing file name, or overwrite the
existing file with no warning. (Check the Warn on file overwrite check box.)

b. Save the scanned images as a multi-page file. (Check the Multi-page file check
box.) (See page 63.)

c. Save the scanned images using a naming schema. A naming schema automatically
names each page’s image file with an automatically-generated name that can
include file name, batch number, page number, side, and other information. (Check
the Use Naming Schema check box and optionally edit the naming schema.) (See
page 63.)

4. Specify a file name in the File Name text box. You can specify any valid file name
(including long filenames and Internet URL path names if your operating environment
supports these), but note the following:

a. The file name may be truncated by the naming schema, especially in Windows 3.x
environments where only eight characters may be used in a filename.

b. The file name extension is automatically supplied according to the image file type.
However, if you specify an extension, or if your naming schema specifies an
extension, PixView will use that extension instead.
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5. Click OK. If you have already loaded pages in your scanner’s document feeder, and
your scanner has a stack sensor, PixView starts scanning immediately. If you have not
loaded pages into your scanner, or if your scanner does not have a stack sensor, the
following dialog appears:

 

6. Assuming you want to scan from your scanner’s document feeder, place a stack of
pages in the feeder, then click Start Scanning. In a moment, your scanner will start
scanning pages and continue until the feeder is empty. When the feeder is empty, the
above dialog again appears.

7. At this point, you can choose to:

a. Stop scanning. To do this, click Stop Scanning. Go to “Viewing Pages” on
page 38.

b. Continue scanning. To do this, load more pages in your scanner’s document feeder
and click Start Scanning.

c. Turn the document over to scan the backs of the pages. To do this, select the Back
of sheet m, batch n option button, then click Start Scanning. If you chose a
double-sided naming schema, your pages will be automatically numbered (or
named a/b, etc.) for easy identification. For more information on double-sided
scanning, see page 32.
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Scanning a Rotated Batch

To use this feature with standard letter-sized paper, your scanner must be able to
scan a document as wide as the length of your page, typically 11".

If desired, you can have PixView scan and rotate pages from landscape to portrait
orientation in a single operation. This ability is designed to increase throughput on large
format (11" wide) scanners by allowing you to scan 8½" x 11" pages sideways. Since the
scanner moves 8½" rather than 11" of paper through its feeder, throughput may be increased
by almost 25%.

To scan a rotated batch, follow these steps:

1. Choose Scan Rotated Batch to File from the File menu. The document naming dialog
appears, just as when choosing Scan Batch to File, but without the Save Orientation
option.

2. Select the desired options as when performing a normal scan batch operation.

3. Load pages in your scanner’s document feeder in landscape orientation. You may need
to experiment to obtain the correct final orientation. Start by rotating the pages 90º
counter-clockwise, feeding the left margin first.

4. Click OK to scan the pages. If you inserted the pages correctly, you will see your pages
in normal orientation in the PixView window. If your pages are upside-down, start
over. This time rotate the pages 90º clockwise.

Scanning Single Pages

Single page scanning is useful if you want to scan and view, scan and print, or scan and save
a single page. You can scan a single page many times while you adjust scanning parameters
such as brightness and contrast, until you achieve optimum settings, and then start scanning
batches.

To scan a single page, choose Scan Page from the File menu.

 Note

 When you scan a single page by using the Scan Page command, PixView
assumes that you either have a page in your scanner’s document feeder or
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on the flatbed. If there is no page in the feeder, PixView scans from the
flatbed without further prompting.

 Important

 When you choose Scan Page, any open pages or documents are closed. If
you are in the middle of a Scan Batch to File operation or are viewing an
open document, this is not a problem. However, if you had previously
acquired an image by using the Scan Page command and have not saved
it, the page image will be lost. If you are scanning to adjust scanner
settings, this will not be a problem. However, if you are scanning pages
for viewing, printing, and/or saving, you must be sure to perform these
operations before choosing Scan Page again.

As soon as the page is scanned, PixView displays it. Go to “Viewing Pages” on page 38.

Rescanning Pages

Rescanning lets you replace an existing page in your document with another. You may need
to rescan because of a scanner misfeed, upside down page in the stack, or other problem. To
rescan a page, follow these steps:

1. Go to the page that you want to replace. See “Going to Other Pages” on page 40.

2. Place the page to rescan in your scanner.

3. Choose Rescan Page from the File menu.

 Note

 When you rescan by using the Rescan Page command, PixView assumes
that you either have a page in your scanner’s document feeder or on the
flatbed. If there is no page in the feeder, PixView scans from the flatbed
without further prompting.

 The page that you scan replaces the current page in the PixView window and in your
document (if any).



PixView User’s Guide

32

Canceling Scanning

Once you have started scanning, you can cancel scanning at any time. To cancel scanning,
either:

• Choose Cancel Scan from the File menu, or
• Press C

Scanning stops as soon as PixView is able to regain control of the scanner (which may not
be until the current page’s scan completes).

Double-Sided Scanning

To use this feature, your scanner must have an automatic document feeder. To
scan double-sided pages on a flatbed scanner, simply scan each side of the page in
the correct order.

PixView supports double-sided scanning in one of two ways. depending on the capabilities
of your scanner:

1. One pass: If you have a duplex scanner, PixView scans both sides of the page at one
time, keeping the pages in the correct order.

2. Two pass: If you have a simplex scanner, PixView scans all of the front sides of all
pages, then gives you the opportunity to turn the stack over and scan the back sides. The
pages are placed into the correct order as they are scanned.

PixView supports one-pass double-sided scanning on supported duplex scanners. Duplex
scanning is enabled and disabled from the Prepare Scanner dialog that appears when you
start scanning with no pages in the document feeder.

If you have a traditional single-sided scanner, PixView lets you scan both sides of a stack of
pages, one side at a time. To do this, follow these steps:

1. Place your document (or a portion of your document) in the scanner’s document feeder,
so that the front sides of the pages will be scanned. You can place as many pages as
will fit in the feeder at one time. (Check your scanner’s documentation for feeder
capacity.)
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2. Choose Scan Batch to File from the File menu, supply the appropriate settings (see
page 27), and scan all of the fronts of the stack.

3. After scanning the last front page of the stack, PixView displays the following dialog:

 

4. Turn the whole stack over and reinsert in your scanner’s document feeder, so that the
back sides of each page will be scanned, from last through first.

5. Choose the Back of sheet n option button.

6. Click Continue Scanning.

 Note

 If the number of back pages scanned does not match the number of front
pages, you will see an error message with options for either rescanning
the stack or ignoring the discrepancy.

7. When all pages in the stack have been scanned, the Prepare Scanner dialog again
appears. Note that if you have scanned the correct number of back sides, the Back of
sheet n option button is dimmed (unavailable). At this point, you can either:

a. Click Stop Scanning to stop scanning and perform other operations.

b. Place the front sides of the next stack of pages into your scanner’s document feeder
and click Continue Scanning. Continue scanning fronts and backs of each stack
until you are done with your entire document.
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Using Job Separators

To use this feature, your scanner must provide some mechanism for job separator
detection. This is typically accomplished by using special separator sheets, a
console button, or a foot pedal connected to the scanner.

Job separators let you automatically separate stacks of pages into separate jobs. Jobs are
separated by choosing or creating a naming schema that includes a job identifier. The job
identifier may be a variation of a file name or it may be differentiation by directory.

To use job separators, follow these steps:

1. If your scanner uses separator sheets, place a separator sheet in the stack at the end of
each job. Do not load the pages into the scanner’s document feeder. If your scanner has
a different method of batch detection, arrange the first batch of sheets to be scanned.

2. Choose Scan Batch to File from the File menu. The document naming dialog appears,
as shown on page 27. Make the appropriate selections and type a base file name for the
batch. Choose a naming schema that includes a job identifier. For information on using
a naming schema, see page 63.

3. Click OK. The Prepare Scanner dialog appears:
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4. Choose the desired batch mode from the Batch Detection list box. The choices available
depend on which scanner you are using, and may include some or all of the following:

 None  The separator sheet is not detected, but is scanned as an
ordinary page.

 Detect and Scan Separator,
Continue Scanning

 The separator sheet is detected and scanned; any
information on the separator is saved as the last sheet of
the current job. Scanning continues with the next job.

 Detect and Scan Separator,
Stop Scanning

 The separator sheet is detected and scanned, so any
information on the separator is saved as the last sheet of
the current job. Scanning stops and the prepare scanner
dialog reappears.

 Detect and Skip Separator,
Continue Scanning

 The separator sheet is detected but not scanned.
Scanning continues with the next job.

 Detect and Skip Separator,
Stop Scanning

 The separator sheet is detected but not scanned.
Scanning stops and the prepare scanner dialog
reappears.

 Important

 If you are scanning double-sided pages with job separators, you should
always choose “Skip Separator.” Otherwise, the separator will be scanned
as the last sheet of the job on the fronts, and the first sheet of the next job
on the backs, because scanning backs proceeds from last through first. If
separators are scanned as part of a double-sided job, the entire job’s
naming schema will be confused.

7. Load your stack in the scanner’s document feeder, then click Start Scanning.

ScanAhead

ScanAhead is a feature that keeps your scanner running at its maximum speed, even if your
application program temporarily cannot keep up.
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 Important

 Not all scanners support ScanAhead. If your scanner does not support
ScanAhead, then the ScanAhead check box will not appear in the Prepare
Scanner dialog as described below.

By default, ScanAhead is enabled. To disable or re-enable ScanAhead, follow these steps:

1. Display the Prepare Scanner dialog by starting a Scan Batch to File operation with no
page in the scanner’s ADF.

2. In the Scanning Options section of the dialog, click the ScanAhead check box. When
there is a check in the box, ScanAhead is enabled. When there is no check in the box,
ScanAhead is disabled. If there is no ScanAhead check box, your scanner does not
support ScanAhead.

Opening Documents

PixView can open any supported image file type. Since a document can consist of many
pages, and often each page image is a separate file, PixView lets you specify multiple files
when opening a document.

 Note

 A document can consist of any number of pages; however, the PixView
viewer can handle a maximum of 500 files at one time.

Reasons for Opening Documents

There are several not-so-obvious reasons to open documents with PixView:

• Viewing and printing images. (See page 38 for viewing pages, page 45 for printing
pages.)

• Faxing images (if your computer has a Windows fax modem driver configured as a
printer).

• Rotating pages and saving the new orientation. (See pages 63 and 69 for two different
methods of changing saved page orientation.)
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• Converting images files from one file format/compression/color format to another file
format/compression/color format. (See page 54 for information about saving documents
with the settings you want.)

• Collecting individual image files into a multi-page file format (See page 54 for
information about saving documents with the settings you want.)

• Organizing individual image files into a naming schema/directory structure. (See page
63 for information about naming schemas.)

To open a document, follow these steps:

1. Choose Open Document from the File menu. The following dialog appears:

 

2. Select the drive and directory which contains the files you want to open. If necessary,
change the setting in the List Files of Type list box to see the files of interest.

3. Select the files you want to open by one or more of the following methods:

a. Click to highlight a file, then click Select to put it in the Selected Files list.

b. Double-click a file to put a file in the Selected Files list.

c. Click the first file of the document, then hold down the SHIFT key while clicking the last
file in a contiguous list. This will highlight the entire range of files between the first and
last. Click Select to put the entire group in the Selected Files list.



PixView User’s Guide

38

d. Click the first file of the document, then hold down the CTRL key while clicking
other files. Each time you click, the file you are pointing to is highlighted. When
you have selected all the files for your document, click Select to put them in the
Selected Files list.

e. Click the first file of the document, then hold down the mouse button and drag
through the list to select a range of files. Click Select to put the highlighted files in
the Selected file list.

f. Click Select All to select all of the files in the File Name list and put them in the
Selected Files list in a single operation.

4. After you have selected all of the files you want to open, click OK to open the
document. The first file in the document now appears in the PixView window.

Viewing Pages

The PixView viewer lets you see your images in many useful ways. You can zoom, rotate,
and move from one image to another. You can use the Pan window for moving quickly
around the image, and you can use the Thumbnail viewer to quickly select a page from any
number of pages in your document. Also, you can change page settings to make your pages
as clear and readable as possible.

Zooming

Zoom in and out using the toolbar. There are several different zooming tools:

Tool Page
command

Shortcut
Key

Result

Fit to width F2 Scales the image to fit the width of the PixView
window. If you change the size of the window, the
image size changes automatically to maintain fit-to-
width.

Fit to
window

F3 Scales the image to fit within the window. This
setting ensures that you always see the entire image.
If you change the size of the window, the image size
changes automatically to maintain fit-to-window.
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Tool Page
command

Shortcut
Key

Result

1:1 F4 Displays one pixel of the image for each pixel in the
display. If you change the size of the window, the
image size does not change.

Zoom in + Zooms in an amount specified in the Zoom Factor
setting of Application Settings, described on page 74.

Zoom out – Zooms out an amount specified in the Zoom Factor
setting of Application Settings, described on page 74.

Zooming With the Mouse

You also can zoom in and out by using the mouse. To do this, point to the image, click and
hold the left mouse button, and drag a selection rectangle that defines the area you want to
magnify. Release the left mouse button, then click the right mouse button. When you click
the right mouse button, the area defined by the selection rectangle instantly fills the PixView
window.

Rotating

PixView can rotate your images in 90º increments:

Tool Page
command

Shortcut
Key

Result

Rotate CTRL+1
CTRL+2
CTRL+3
CTRL+4

Rotates the current page 90º clockwise each time it
is clicked. The shortcut keys represent 0º, 90º, 180º
and 270º rotation, respectively.

Note that the image is rotated around the current window view point, so if you are zoomed
in, you will not lose your point of reference when you rotate the view.

Tip: Rotating an image affects the view of the image only, not the actual file.  To save a file
once you have changed the image rotation, you must check the Use Current Orientation
check box. (See page 56). Or, to save just the current image in its current orientation, choose
Replace Page w/ New Orientation from the File menu.
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Using the Clipboard

PixView can copy either the entire image or a selected portion to the Windows Clipboard.

To copy the entire image to the Clipboard, choose the Copy command from the Edit menu,
or press CTRL+C.

To copy a selected area of an image to the Clipboard, first select an area by dragging a
selection rectangle with the mouse. Point to the upper left corner of the area you want to
select, then press and hold down the left mouse button. Move the mouse to define a
rectangle around the area you want to select, then release the mouse button. Next, choose
the Copy command from the Edit menu, or press CTRL+C. The following dialog appears:

Click Yes to copy just the selection to the Clipboard. Click No to copy the entire image to
the Clipboard.

Once you have copied an image to the Clipboard, you can paste it into another application.
(Consult the documentation for your other applications to determine whether or not they
support pasting of images from the Windows Clipboard.)

Going to Other Pages

There are several ways to go from one page to another:

Tool Page
command

Shortcut
Key

Result

Previous
Page

CTRL+P Displays the previous page of your document.
Dimmed if you are viewing the first page.

Next Page CTRL+N Displays the next page of your document. Dimmed
if you are viewing the last page.
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Tool Page
command

Shortcut
Key

Result

Goto Page CTRL+G Goes directly to the page number you enter in the
Goto dialog.

Show
Thumbnails

T Displays the Thumbnail window from which you
can jump to any page by clicking on it. See page 42.

Using Scroll Bars

Scroll bars are the traditional Windows method of navigating around pages. In PixView,
scroll bars are always enabled, and work just as you would expect.

Using the Pan Window

Scroll bars are tedious to use when navigating around large or highly-magnified images.
The Pan window is a much more efficient tool. To use the Pan window, follow these steps:

1. If you do not see the Pan window, it is disabled. To enable the Pan window, either
check Display Window in the Pan Window group of the Application Settings dialog, or
press P  while on the main PixView window.  The Pan window looks like this:

 

 The reversed (black) area in the Pan window represents the area displayed in the main
PixView window. If your entire Pan window is reversed, then the entire image is
visible in the main window. You must then zoom in before you can use the Pan
window.

2. Point to the reversed area of the Pan window, then click and hold down the left mouse
button.
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3. Drag the mouse and watch the image in the main window change.

4. If desired, you can change the size of the Pan window by dragging its corner borders.
Generally, the Pan window’s default size is adequate.

5. The Pan window always stays on top of the PixView window. If the Pan window is in
your way, you can move it by pointing to its title bar and dragging. You can place the
Pan window anywhere on your screen—it does not have to be within the PixView
window.

6. To close the Pan window, click the close button or press P.

The Pan window has some additional settings that are explained on page 74.

Displaying Thumbnails

Thumbnails are miniature representations of each page of your document. Displaying
thumbnails is a convenient way to see an overview of your entire document and to quickly
go to a particular page.

 Note:

 The Thumbnail Viewer is included with PixView as an example of the
kinds of features that can be implemented by using PixTools products. It
is not intended to be used in a production environment and may give less-
than-satisfactory results.

To display thumbnails, follow these steps:

1. Scan or open a document consisting of at least two pages.

2. Choose Show Thumbnails from the Page menu. (Shortcut: Press T in the main
PixView window.) The following dialog appears:
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3. Select the desired number of thumbnails to display at one time, then click OK. The
Thumbnail window then appears. A typical window looks like this:

 

4. To get a better view of the individual pages, you can enlarge the Thumbnail window by
dragging its corner borders. The Thumbnail window can be made as big as your screen
allows. The Thumbnail window always stays on top of the PixView window. If the
Thumbnail window is in your way, you can move it by pointing to its title bar and
dragging. You can place the Thumbnail window anywhere on your screen—it does not
have to be within the PixView window.

5. To go to a particular page, simply point to it and click.

6. To close the Thumbnail window, double-click the Control-menu icon in the upper left
corner of the window.
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Displaying with ScaleToGray™

When an image is viewed at sizes smaller than 1:1, PixView  must decide which pixels to
show and which pixels to hide. For example, when an image is viewed at 25% of its actual
size, only one pixel out of four is visible. The remaining pixels are disregarded. The
resulting image can be unreadable.

PixView solves this problem with binary (black and white) images by using scale to gray.
Scale to gray represents the average density of missing pixels with a shade of gray, making
reduced images much more readable. To see the improvement, toggle scale to gray off and
on by pressing G from the main PixView window.

Scale to Gray Off Scale to Gray On
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Annotating Pages

Annotations give you the ability to add text, lines, highlighting, and other objects to your
pages. Annotations appear on top of your page images; they do not become a part of the
image data.

 Important

 Because annotation data is saved in TIFF tags, non-TIFF files do not
support saving of annotations. Annotations are saved only when the file
format is TIFF.

To place annotations on your pages, follow these steps:

1. Display the Annotation toolbar. To do this, choose Application Settings from the
Options menu, then check Display Annotation Toolbar in the Display Features group.

 

2. Click OK to close the Application Settings dialog. The Annotation toolbar now appears
near the top of the window.

 

Check this
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3. Click the annotation tool that you want to use.

4. If desired, change the annotation tool’s attributes by using the Annotations menu.

 

 Each annotation tool has a different set of attributes, and each is explained in
“Annotation Attributes” below.

5. Place the annotation. The way in which you place an annotation depends on which
annotation tool you are using. For example, to place a text annotation, click at the
desired starting point, then type text. To place a highlight annotation, click and drag to
define a rectangle.

To move an annotation, use the Select tool. Point to the annotation, then click and drag to
move it.

To resize an annotation, use the Select tool. Point to the annotation and click to select it.
Note that “handles” (small black rectangles) appear in the corners of the annotation.
Position the mouse pointer over one of these rectangles, then click and drag to resize the
annotation.

To delete an annotation, use the Select tool. Point to the annotation and click to select it.
Then press DELETE.
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Annotation Tools

You can place any of eight different types of annotations on your pages. The following table
describes each of the annotation tools:

Annotation
Tool Use

Select annotations for the purpose of moving, resizing, or deleting them, or
changing their properties.

Place a text annotation.

Place a popup icon which, when clicked, opens to a window of scrollable
text.

Draw transparent colored rectangles over areas of the page, similar to the
appearance of a highlighter pen.

Draw opaque, usually black, rectangles over areas of the page to obscure
them from being seen.

Draw freehand lines.

Draw straight lines arrowheads on either or both ends, or no arrowheads..

Draw rectangles.

Place a bitmap image that you specify.
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A typical annotated page might look similar to the following on your screen:

Text annotation

Arrow annotation

Highlight
annotation

Line annotation

Redact
annotation

Box annotation

Stamp
annotation

Popup icon

Popup window
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Annotation Attributes

Each type of annotation has various attributes that you can set as desired. This section
explains each of these annotation attributes.

You can change the attributes either before or after you place an annotation:

• To change the attributes before you place an annotation, use the Annotations menu.

 

• To change the attributes of an existing annotation, move the mouse pointer over the
annotation. (When property positioned, the mouse pointer changes from an normal
arrow to a four-headed “move” arrow.) Then right-click to display a popup attributes
menu. Make a selection from this menu to change the annotation.

Popup attributes
menu
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The following table describes each annotation attribute:

Annotation
Tool Attribute Effect

Text Color
Font
Opaque

Set the color of the text
Set the font, font style, size, effects, and color
Toggle whether text is transparent or opaque

Popup Text Color
Font

Set the color of the popup text icon
Set the font of the popup text and caption text

Highlight Color Set the color of the highlighter

Redact Color Set the color of the redacted area

Line Color
Width
Transparent

Set the line’s color
Set the line’s width in unscaled pixels
Toggle whether line is transparent or opaque

Arrow Color
Width
Arrows
ArrowHeads
Transparent

Set the arrow’s color
Set the arrow’s line width in unscaled pixels
Choose arrowhead at head, tail, both, or none
Choose hollow or solid arrowheads
Toggle whether arrow is transparent or opaque

Box Color
Width
Transparent

Set the color of the box outline
Set the box outline’s width in unscaled pixels
Toggle whether the box outline is transparent or opaque

Stamp File Choose the bitmap file to use as a stamp
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Printing Pages

By using the various printing commands in PixView, you can print your pages in a number
of useful ways. Each print command (except Print Thumbnail) lets you optionally print a
selection. A selection is an area of a page that you determine by drawing a rectangle on the
page image prior to choosing one of the print commands, as shown:

To print, follow these steps:

1. If you want to print a selection, use the mouse to select an area of a page by drawing a
rectangle around the desired area. To change the size of the selection once you have
made it, hold down the SHIFT key, click the left mouse button and continue stretching
the selection rectangle. To start a new selection, simply click anywhere on the image
and drag.

Selection made
by dragging the

mouse
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2. Choose one of the print commands from the File menu:

Print (Fit Page) Prints each page image (or selection) scaled so that it fits
the printer’s page size.

Print (Actual Pixels) Prints each page image (or selection) with one printer
pixel for each pixel in the image.

Print (Actual Size) Prints each page image (or selection) in its original size.
If the image is bigger than the printer page size, only a
portion of the image will print. PixView does not tile
images when printing. For normal 8½" x 11" pages and
printers, this will amount to cropping about ¼" along
each edge.

Print Thumbnails Prints a specified number of page images on each page.

 If you chose Print Thumbnails, the following dialog appears:

 

 Choose the number of images to print on each page and, if desired, enable printing of
borders and/or filenames for each image. Click OK.

1. After choosing a print command (and, if printing Thumbnails, choosing a Thumbnail
layout), the following dialog appears:
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2. Choose the desired printing options:

a. If necessary, click Setup to choose the printer you want to use and set its options.
Click OK when done.

b. Choose a print range. All prints all pages in your document. Selection prints only a
previously-defined selection on a single page. If no selection exists, this option is
dimmed. Pages prints the range of pages you specify in the From and To text
boxes.

c. Click the Properties button to change printer settings. These settings vary
according to your printer’s capabilities.

d. Specify the number of copies to print and whether or not to collate. For multipage
documents, collating is more convenient. When making several copies of each
page, not collating may result in faster printing.

3. Click OK to start printing.
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Printing Annotations

If you have pages with annotations and you want those annotations to print, be sure that
Print Annotations is checked in the Annotations menu.

 

Saving Pages and Documents

In almost all cases, your pages are automatically saved as you scan them, according to the
instructions you specify in the Scan batch to file dialog. You only need to save pages or
documents in the following cases:

1. You scanned a single page using the Scan Page command. (The resulting image is not
automatically saved.)

2. You want to make a change to the file format, compression, or color format.

3. You want to change the orientation of the image in the file.

4. You want to change the naming schema.

5. You want to change from individual files to a multi-page file format or vice-versa.

Saving a page is exactly the same as saving a document; the only difference is the save
range, explained below. To save a page or a document, follow these steps:

1. Choose Save Page As or Save Document As from the File menu. The following dialog
appears:
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2. Choose:

a. An image file format from the List Files of Type list box (see page 56).
b. A color format from the Color Format list box (see page 58).
c. A compression option from the Compression list box (see page 56).

3. Decide whether to:

a. Have PixView warn you if you specify an existing file name, or overwrite the
existing file with no warning. (Check the Warn on file overwrite check box.)

b. Save the document as a multi-page file. (Check the Multi-page file check box.)
(See page 63.)

c. Save the document using a naming schema. A naming schema names each page’s
image file with an automatically-generated name that can include file name, batch
number, page number, side, and other information. (Check the Use Naming
Schema check box and optionally edit the schema. (See page 63.)

d. Save the document using the original orientation or the current orientation.
Normally, the document is saved in the original orientation. If you have rotated
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pages and you want to save them in their current orientation, you must check the
Use Current Orientation check box.

4. Specify a starting page number and starting batch number for the document. If you are
using a naming schema, these settings will affect the resulting file names.

5. Choose a range of pages to save. If you chose the Save Page As command, the Current
Page box is checked by default. If you chose the Save Document As command, the All
Pages check box is checked by default. If you want to save a range of pages, check the
Page Range check box and enter a page number in the From and To text boxes.

6. Select a drive and directory in which to save your page or document, and type a file
name in the File Name text box. You can specify any valid filename, but note the
following:

a. The filename may be truncated by the naming schema, if one is being used. This is
especially true when using Windows 3.x with its limited eight-character filenames.

b. The filename extension is automatically supplied according to the image file type.
However, if you specify an extension, or if your naming schema specifies an
extension, PixView will use that extension instead.

7. Click OK to save the document. While PixView is saving the document, you will see a
progress monitor similar to the following:

 

Selecting File Formats and Compression Options

PixView supports a number of popular image file formats. You can choose from among the
following according to the requirement of other applications. If possible (for binary images),
you should choose TIFF JBIG or TIFF Group 4, which can achieve a 35:1 to 50:1
compression ratio, depending on the characteristics of the image.
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Format
Extension File Format

Multi-page
Support?

Color/gray
support?

Compression
Options1

TIF (also see
Plexus TIFF)

Tagged Image File
Format (TIFF)

Yes Yes CCITT Group 4
CCITT Group 3
Modified Group 3
JBIG
Enhanced JBIG
JPEG
Packbits
ZIP
WANG JPEG
None

TIF Plexus TIFF No Yes CCITT Group 4
CCITT Group 3
Modified Group 3
Packbits
None

PCX ZSoft PC Paintbrush No Yes RLE

DCX ZSoft PC Paintbrush
FAX extension

Yes No RLE

BMP Microsoft Windows
Bitmap

No Yes None
RLE for some
   color formats

JBG JBIG No Gray JBIG,
Enhanced JBIG

JPG JPEG JFIF No Yes JPEG

PDA Calera Processed
Document
Architecture

No No CCITT Group 4
CCITT Group 3
None

                                                          

1Available compression options may vary according to selected Color Format.
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Format
Extension File Format

Multi-page
Support?

Color/gray
support?

Compression
Options1

PDF Portable Document
Format (Adobe
Acrobat)

Yes Yes CCITT Group 4
CCITT Group 3
ZIP

PNG Portable Network
Graphics

No Yes ZIP

CAL DOD CALS No No CCITT Group 4

MDA IBM MO:DCA Yes Yes CCITT Group 4
JPEG
None

How to Choose a File Format

Different file formats produce files with different characteristics and sizes. Often, your
choice of file format will depend on the requirement of other image applications that must
use the images captured in PixView. However, if you have more than one choice of file
format, you may want to determine the best format for your application. There are three
settings that affect the file format:

1. File Type (TIFF, PCX, BMP, etc.)

2. Color Format (Binary, Gray scale, 8-bit Palette, 24-bit color, etc.)

3. Compression (None, Packbits, CCITT Group 4, etc.)

When saving documents, keep in mind their intended use. If you do not need color or gray
scale, you should probably save using the binary setting because the resulting files will take
up much less disk space. Each pixel of a binary image requires one bit of disk space
(uncompressed). Each pixel of a 24-bit color image (which provides 16 million color
possibilities) requires 24 times as much disk space. Generally, binary images compress
significantly better than color or gray scale images.

The available color format settings vary according to the file type selected. The compression
settings vary according to both the file type and color format settings. In the following brief
descriptions, compression is the compression options available in PixView listed from best
(most compression) to worst (least compression).
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BMP Windows (and OS/2) Bitmap

Advantages: Wide support under Microsoft Windows. Handles black-and-white, gray
scale, palette color and 24-bit color images.

Disadvantages: Poor support outside of Windows (OS/2). Poor support for compressed
files. Does not support multiple images per file.

Compression: Binary: None

Gray/Palette Color: RLE, None

24-bit Color: None

CALS Department of Defense Computer Aided Logistics Support

Advantages: Compatibility with CALS imaging systems.

Disadvantages: PixView only reads CALS files; it does not write them.

Compression: CCITT Group 4

DCX Fax Extension of PCX

Advantages: Same as PCX, but black-and-white only. Supports multiple images per
file.

Disadvantages: Same as PCX.

Compression: Binary: RLE

JBIG Joint Bilevel Imaging Group

Advantages: Excellent binary and gray scale compression.

Disadvantages: No support for color. Not widely supported at this time.

Compression: Binary: JBIG

Gray: JBIG

JBIG is both a file format and a compression scheme, and is available in
JBIG files as well as in TIFF files.



PixView User’s Guide

60

JPEG Joint Photographic Experts Group Compressed Bitmap

Advantages: By far the best compression for photographic images.

Disadvantages: Many incompatible implementations. Lossy, meaning that color and
image data is discarded to save storage space at the expense of image
qualities that typically are below the threshold of human vision.

Compression: JPEG is a compression scheme, which can be used in other file types. The
correct name for a stand-alone JPEG file is JFIF. On the PC, these files
typically have the extension JPG.

MO:DCA IBM Mixed Object: Document Content Architecture.

Advantages: Compatibility with IBM imaging systems.

Compression: CCITT Group 4

PCX ZSoft PC Paintbrush Image File Format

Advantages: Widely supported on PC platforms. Supports black-and-white, gray scale,
palette color and 24-bit color images. Reasonably efficient storage of
images with large areas of constant tone. Images are always compressed
using run-length encoding (no user choice).

Disadvantages: Run-length encoding is inefficient for storing typical scanned images.
Produces files twice the size of TIFF Packbits. Generally not supported on
non-PC platforms.

Compression: Binary: RLE

Gray/Palette Color: RLE

24-bit Color: RLE

PDA Caere Corporation Processed Document Architecture

Advantages: Single file format can contain bitmap image data or text. Very good
compression is possible.

Disadvantages: Very little support other than Caere applications (WordScan, M/Series
Professional). No color support. (Developed for OCR applications.)



Chapter 4—Using PixView

61

Compression: Binary: CCITT Group 4, CCITT Group 3, None

Plexus TIFF Modified TIFF Format for Plexus Software

Advantages Compatibility with Plexus imaging systems.

Disadvantages Only support a subset of the regular TIFF features.

Compression Binary: CCITT Group 4, CCITT Group3, CCITT Modified
Group 3, Packbits, None

Gray: Packbits, None

Palette/24-bit Color Packbits, None

PDF Adobe Acrobat Image File Format

Advantages Compatibility with Adobe Acrobat.

Disadvantages PixView only reads image-only PDF files.

Compression Binary: CCITT Group 4, CCITT Group3, ZIP

Gray: JPEG, ZIP

Palette/24-bit Color JPEG, ZIP

PNG Portable Network Graphics

Advantages May become a replacement for GIF as the standard web graphics format.
Superior to GIF because it also supports binary and 24-bit color.

Disadvantages Not widely supported at this time.

Compression ZIP

TIFF Aldus/Microsoft Tagged Image File Format

Advantages: Handles black-and-white, gray scale, and color images well. Supports
multiple images per file in PixView’s implementation. Works across
multiple platforms. Available in most commercial imaging applications.
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TIFF with JBIG compression provides the best binary and gray scale file
compression. TIFF with JPEG compression provides excellent color file
compression.

Disadvantages: So flexible that many implementations are not complete; therefore, TIFF
files from one application may not be compatible with another
application’s implementation. Format also allows for private, undisclosed
data field formats making certain implementations closed to other
applications.

Compression: Binary: CCITT Group 4, CCITT Modified Group 3, CCITT
Group 3, JBIG, Enhanced JBIG, ZIP, Packbits,
None

Gray: JBIG, Enhanced JBIG, ZIP, Packbits, None

Palette/24-bit Color JPEG, WANG JPEG, Packbits, ZIP, None

Summary: Group 4 compression provides the best compression for black & white
images. Modified Group 3 provides half the compression but is more
widely supported. JPEG is lossy, meaning that it discards some of the
original image’s information in order to attain a higher compression. PCX
is more widely supported and is not lossy.

Choose a compatible format as close to the top of the following lists as
possible:

Binary images:

1. JBIG

2. TIFF Group 4

3. TIFF Group 3 Modified

4. TIFF Group 3

5. TIFF Packbits

6. PCX

7. TIFF Uncompressed
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Color/gray scale images:

1. JBIG (gray scale only)

2. JPEG

3. TIFF Packbits

4. PCX

5. BMP

 Note

 Dithered images generally compress very poorly, due to the large number
of transitions in pixel values. Sometimes compressed dithered images can
be larger than their uncompressed counterparts.

Changing Page Orientation

PixView maintains the orientation of the images in the files you save unless you specifically
instruct it to change the orientation. If you want to save the orientation of each image in the
file after rotating some or all of the images, check the Use Current Orientation check box.
(See page 56.)

Multipage Options

A multi-page file is a single file that can contain multiple images. The formats that support
multi-page files are listed in the table on page 56. Note that the application in which you
intend to view, manipulate, or print the images must also support multi-page files;
otherwise, you may see just the first page of a multi-page file, or the program may display
an error message or crash.

Naming Schemas

Naming schemas let you automatically name large batches of scanned pages in such a way
that they are easily identifiable. You can choose from a list of common naming schemas or
you can create your own to meet the requirements of your job. Schemas can be thought of as
“pictures” of how you want your documents’ file names to look, including automatically-
generated batch number, page numbers, and side identifiers.
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To use naming schemas, check the Use Naming Schema check box in the Save Document
As, Save Page As, or Scan Batch to File dialog. The currently-selected naming schema
appears just below this check box:

Selecting a Naming Schema

To select a different naming schema, click Edit Schema. The following dialog appears:

Note that the file name specified prior to clicking Edit Schema was scan. Choose the
desired naming schema from the Schema drop-down list box. To see hypothetical results of
each schema, refer to the list of Sample Files Generated. Note that in the example shown
above, a double-sided document could not be saved, because the naming schema results in
an illegal path name for the backs of pages. Other supplied schemas make provisions for the
backs of double-sided documents as well as for batch identifiers. Some of the naming
schemas even divide large jobs into directories each containing no more than a
predetermined number of files. This can be important in large jobs, because the performance
of the DOS file system slows down considerably as more and more files are added to a
given directory.
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Selecting a Predefined Naming Schema

PixView has several predefined naming schemas. You can choose the desired predefined
schema from the Schema drop-down list box. Rather than describe all of the schema in this
manual, you can choose each one in turn and note the results under Sample Files Generated.
You also can read a description of how the schema works under the Description heading in
the dialog.

Defining a Custom Naming Schema

If none of the predefined naming schemas meet your needs, you can define your own. To
define a custom naming schema, follow these steps:

1. Select the text in the Schema drop-down list box. It doesn’t matter which schema is
currently selected—this operation does not overwrite the predefined schemas.

2. Type a new naming schema, replacing the text you selected in Step 1. Follow the rules
for naming schemas described in the following section. Note that as you type, the
information under Sample Files Generated changes to show the hypothetical results of
your schema. If you type a schema that results in an illegal filename, the words
illegal path appear under Sample Files Generated.

3. If you want to permanently save the schema, click Add Schema. Your new naming
schema is added to a position in the list determined by ASCII character sort order of the
characters in your schema.

4. Click OK to close the dialog and return to the Document Name dialog.

Naming Schema Formats and Rules

Naming schemas can be entered in one of two different formats:

• PixName format
• Printf format

The PixName format is easy to use, while the Printf format provides more functionality.
The PixName format should be able to represent naming schema for most of your needs.
The general schema format for both naming schemas is:

format[,varlist][;format[,varlist]]
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format can be either a PixName format string or a Printf format string. If format is a
PixName format, then you do not need to enter a varlist. If the naming schema needs to
be different for the front and back sides of sheets, use a semicolon (;) to separate the front
side format from the back side format The string can contain any legal file name characters.
The characters “$,”  “#,” and “%” have special meanings described in the following section,
and must be preceded by “%” if they are to be treated as literal characters in the file name.

varlist is an optional list of expressions that is evaluated for every file name generated
and substituted into the format string. Each expression in a varlist is separated from
the next expression by a comma (,). Up to four expressions can be entered within a single
varlist. An expression is either a text expression or a numeric expression. Text
expressions are limited to the variable “r” that represents the root file name. Numeric
expressions can contain multiple occurrences of the variables “b” and “p” that represent the
current batch number and the current page number, respectively. Numeric expressions also
can contain numbers and mathematical operators. The operators “+,” “ –,” “/,” and “*”
(addition, subtraction, division, and multiplication) are supported. All numerical expressions
are evaluated left to right without regard to operator precedence.

PixName Format Strings

The PixName format uses two special characters, “$” and “#,” to represent place holders
for the root file name, batch number, and page number, as follows:

“$” Place holder for the root file name. The number of consecutive dollar signs has no
bearing on the size of the field the root file name will fill. PixName automatically
truncates the root file name as needed to fit the other requirements of the naming
schema. (Internally, a sequence of dollar signs is translated into the Printf format
“%s” with the variable expression “,r.”)

“#” Place holder for one digit in either the batch number or the page number. A sequence
of three number signs means that a zero-padded number, three characters (or more)
long, is plugged into the file name in place of the number signs. For example, if the
format string “pix####,p” is entered, and the page number is 17, then the file
name generated would be “pix0017.”

The first sequence of number signs is always a place holder for a page number
expression involving the variable “p” unless a second sequence is entered. If a
second sequence of number signs is detected, then the first sequence becomes a place
holder for the batch number (variable “b”) and the second sequence becomes the
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page number expression.

If you enter only one PixName format string that is not followed by a varlist,
then PixView assumes that a double-sided document is being created. This implies
that the front sides of sheets have odd page numbers and the back sides of sheets
have even page numbers. The Printf expression that creates this series for input page
numbers “1, 2, 3,...” is “,p*2-1” for front side page numbers and “,p*2” for back
side page numbers. If you enter different front and back side format strings,
PixView assumes simple page numbering using the simple Printf expression “,p”
for both the front and back sides.

Printf Format Strings

The Printf format allows a subset of the output formatting available in the C language printf
function call. The format string can contain any characters, symbols, or digits permitted by
the file system in file names. Portions of the string that begin with the percent sign (%) have
special meanings that usually represent a place holder for an evaluated expression that will
be substituted. The general form for a “%” specification is:

%[0width]type

These characters and fields have the following meanings:

0 Pads the output number with zeros. The number is right justified within the
specified width characters. Any characters to the left of width spaces not
used by the number are filled with zeros.

width Minimum number of spaces a number will occupy. Numbers larger than width
characters are not truncated. A number is right aligned within the width field.

type Type of value to be substituted into the string. The following types are
supported:

type Meaning

c Insert a single character having an ASCII value determined by
the corresponding expression in varlist.

d, i Insert a signed decimal integer argument.

ld, li Insert a long signed decimal integer argument.
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type Meaning

u Insert an unsigned decimal integer.

x Insert an unsigned hexadecimal integer argument in lower case.

X Insert an unsigned hexadecimal integer argument in upper case.

lx,lX Insert an unsigned long hexadecimal integer argument in the
indicated case.

s Insert a character string.

Schema Entry Rules

Following are a few rules for entering naming schemas:

1. Do not mix formats. Use either PixName format or Printf format.

2. If you use PixName format, varlist  is generated automatically, even though it is
not visible. You can type in your own varlist if necessary.

Do not enter full path names as part of the format. PixView will provide a “prefix” portion
of the file name that is not displayed in the samples of the dialog. Entering drive letters will
cause an “illegal path” error.

Schema Examples

The following table gives several examples of both PixName Format and Printf Format
strings.

PixName
Format Printf Format

Resulting File Name
(base name = abcdefgh.tif)

HELLO HELLO (front) hello.tif
(back) hello.tif

$ %s,r (front) abcdefgh.tif
(back) abcdefgh.tif
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PixName
Format Printf Format

Resulting File Name
(base name = abcdefgh.tif)

## %02d,p*2-1;%02d,p*2 (front) 01.tif
(back) 02.tif

HELLO## HELLO%02d,p*2-1;
HELLO%02d,p*2

(front) hello01.tif
(back) hello02.tif

$$$-### %s-%03d,r,p*2-1;
%s-%03d,p*2

(front) abcd-001.tif
(back) abcd-002.tif

####\SCAN#### %04d\SCAN%04d,b,p*2-1;
%04d\SCAN%04d,b,p*2

(front batch 1) 0000\scan0001.tif
(back batch 1) 0000\scan0002.tif
(front batch 17) 0017\scan0001.tif
(back batch 17) 0017\scan0002.tif

SCAN###A;
SCAN###B

SCAN%03dA,p;SCAN%03dB,p (front) scan001a.tif
(back) scan001b.tif

$##\$.### %s%02d\%s.%03d,r,b,r,p*2-1;
%s%02d\%s.%03d,r,b,r,p*2

(front) abcdef01\abcdef.001
(back) abcdef02\abcdef.002

Saving a Selection

In the same manner as printing a selection (described on page 45), you can save a selected
area of a single page or a selected area on each page of an entire document. To save a
selection, follow these steps:

1. Use the mouse to select the area of the page you want to save, or the area you want to
save on each page of an entire document. (When saving a document, the same selection
is saved on every page of the document.) To select an area, use the mouse to draw a
rectangle. To change the size of the selection once you have made it, hold down the
SHIFT key, click the mouse button, and continue stretching the selection rectangle. To
start a new selection, simply click anywhere on the image and drag.

2. Choose Save page as or Save document as from the File menu. The Save dialog
appears, but with an additional check box, as shown:
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3. Note that the “Selected area” check box is checked by default. If you have defined an
area but don’t want to save an area, clear the check box.

4. Complete all other information in the Save dialog normally, then click OK. If you are
saving a document, the entire document will be saved by applying the selection to each
page, and only saving the portion that falls within the selected area.

Replacing a Page with a New Orientation

You can change the orientation of individual pages in your document, and then save that
orientation in either of two ways. This section describes a way of changing the current
page’s orientation. The method of saving the current orientation of all pages in a document
is described on page 63.

When you choose Replace Page w/ New Orientation from the File menu, the result
depends on the image format you are using to save the page or document. If you are using
TIFF, the current page’s orientation tag in the image header is changed. The orientation of
the image itself is not changed. The orientation of the image you will see in another image
application depends upon the other application’s support of the orientation tag. Image
formats other than TIFF do the following:

1. If saving in a single-page file, the original file is deleted and replaced with a new file
containing the rotated image.

2. If saving a multi-page file, the current page in the file is deleted and replaced with the
new page. Generally, any extra space in the file that is freed by this operation is not
recovered.
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Changing settings

Changing Scanner Settings

To change scanner settings, click the Scan Setup button or choose Scanner
Settings from the Options menu. A dialog similar to the following appears:

The dialog for your scanner may be slightly different, so as to provide controls for all of
your scanner’s features.

Choose settings as desired, and then click OK.

Additional settings also are available from this dialog:

Click To set

Default Return scanner settings to their default values.

Area To set the scanning area. Scanning area is set by specifying a measurement unit,
and then specifying the upper left X and Y positions and the width and height of
the area.

More When enabled, the scanner has additional settings that are scanner-specific. These
additional settings may include separator page detection, gamma curve correction,
binarization matrix selection, pixel patching, and so forth. Consult your scanner’s
documentation for information about these additional settings.

Filters When enabled, the scanner or system has image enhancement filters, such as
deskewing and noise removal. These filters may be available in the scanner
hardware or may be added via software modules.
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Changing Page Settings

To change page settings, choose Page Settings from the Options menu. The following
dialog appears:

Page settings only affect the view of the image on your screen. They do not change the
contents of your image files whatsoever. You can change the following settings:

Setting Effect

Rotation Changes the page orientation in 90º steps.

Mirror Displays a mirror image of the page.

Invert Inverts the image display from positive to negative or negative to positive.

Scaling Changes the scaling of the image to one of several predefined sizes. In
addition, you can type any value between 4 and 200 (percent) in this box.

Scale to
Gray

For black and white images that are being viewed at sizes smaller than 1:1,
changes pixels to shades of gray based on the relative brightness of the
reduced area. This improves clarity of the image.

Brightness
Contrast

Changes the relative brightness of a color, gray scale, or scaled-to-gray
image view.
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Setting Effect

Horz Pres
Vert Pres

With binary images only, changes the threshold at which a black pixel is
converted to white when displaying the image at scale factors less than 1:1.
This can improve readability in some cases without using Scale to Gray
(which may reduce display speed slightly). Note: These settings are
available only when viewing a black and white image with Scale to Gray
disabled.

All Pages Makes changes applicable to all pages in a document. When disabled, only
the current page is affected.

Instant
Update

Makes changes instantly visible in the PixView view window as you make
them. When disabled, changes take effect when you click OK.

Save As
Defaults

Saves all current settings as the default values that will be used whenever a
new document is opened.

Factory
Defaults

Returns all settings to their factory default values.

Color Enables color settings by extending the Settings dialog, as shown in the
following illustration:
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The following color settings can be changed:

Setting Effect

Brightness
Contrast

Change the relative brightness and contrast of each of the primary colors
(Red, Green, and Blue).

Move As
Group

Causes all Brightness or Contrast scroll bars to move in unison, when any
individual slider is moved, thereby keeping the relationship and color
balance the same as the overall brightness or contrast is changed.

Color
Model

Allows selection of the desired color model. At this time, only RGB
(Red/Green/Blue) is supported.

Dither Using dithering to approximate tonal ranges inherent in the image but not
possible to display, either due to the display adapter’s color capabilities or
the scale factor of the image.

View as
Gray

Displays color images as gray scale.

Changing Application Settings

To change application settings, choose Application Settings from the Options menu. The
following dialog appears:
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You can change the following settings:

Setting Effect

Pan Window

Display Window When enabled, PixView always launches with the Pan
window enabled.

Use Scale to Gray Displays the image in the Pan window using Scale-to-
Gray. This results in a better looking image, but may result
in slower display performance if not using a hardware
display accelerator such as ImageAccel.

Display Features

Display Toolbar Displays the toolbar at the top of the PixView window.

Display Annotation
Toolbar

Displays the annotation toolbar at the top of the PixView
window.

Display Toolbar Text Adds text descriptions to the toolbar buttons.

Display while scan Displays the image being scanned while scanning is taking
place. Use this option with slow or color scanners only to
see the image while you are waiting for the scan to
complete. Note that this setting works only when
ScanAhead is disabled, as explained on page 35.

Disable Accelerator Disable hardware image display acceleration. Use this
option if you have a Cornerstone ImageAccel or Sigma
Designs display adapter so that you can compare
accelerated and unaccelerated display performance. This
setting has the same effect as disabling display acceleration
in the PixTools/View Control Panel described in
Appendix A.

Scan Features

Auto Resume Scan For scanners that have stack sensors in their document
feeders, causes PixView to continue scanning as soon as
more pages are inserted. When disabled, causes PixView
to wait until the user clicks the Continue Scanning button.
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Setting Effect

Zoom Factor Sets the zoom amount that occurs when you click the
Zoom In or Zoom Out button.

Scroll Bars This feature is disabled at this time. Scroll bars are always
on.

Color Features

Max 256 Colors When scanning or opening a non-palette (typically 24-bit)
color image, reduces the in-memory image to an 8-bit
optimized palette image. This uses less memory and
produces a faster display. Note: If you save the page or
document, the file will contain the 8-bit palette image, not
the original full color image.
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Changing Printer Settings

To change printer settings, choose Print Setup from the File menu. A dialog similar to the
following appears:

You can change the following settings:

Setting Effect

Printer

Default Printer Selects the printer that is specified in Windows as being
the default printer.

Specific Printer Allows selection of any printer defined in your Windows
setup.

Orientation

Portrait Prints with the top of the image across the narrow
dimension of the paper.

Landscape Prints with the top of the image across the wide dimension
of the paper.

Paper

Size Allows selection of the size of paper on which to print.
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Setting Effect

Source Allows selection of paper tray to use.

Options Displays a dialog of printer-specific settings.
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Appendix A  PixTools/View Control Panel

The PixView CDROM includes the PixTools/View control panel, which enables you to
control hardware-accelerated printing and display. PixTools applications and libraries
support accelerated printing for the following printer accelerators:

• Xionics XIPPrint
• Fujitsu PrintPartner 10i

PixTools applications and libraries also support accelerated image display for Cornerstone’s
ImageAccel display system, and for hardware-accelerated displays from several other
manufacturers.

Accelerated printing and display work by sending run-length encoded compressed image
data from memory or disk directly to the printer or display card. A special card in your
printer or a special display adapter card then decompresses this data using very fast
hardware decompression. Compressed data moves faster over the computer’s bus and the
printer/network cables, and can be read more quickly from a disk drive or from memory,
drastically reducing the amount of time it takes to print or display an image. In addition,
image display acceleration is further increased by attempting to send device-dependent
bitmaps to the display adapter. Accelerated printing and display are enabled and disabled by
using the PixTools/View control panel.

By default, accelerated printing is disabled and accelerated display is enabled (assuming you
have installed a display adapter with supported accelerator hardware). To change the
settings associated with accelerated display and printing, use the PixTools/View control
panel.

The PixTools/View control panel is installed automatically when PixView is installed.
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Using the Control Panel

To use the PixTools/View Control Panel, follow these steps:

1. If you are using Windows 3.1, Windows for Workgroups 3.11, or Windows NT 3.51,
open the Windows Main program group and double-click the Control Panel icon.

 If you are using Windows 95 or Windows/NT 4.0 or higher, open the Start menu and
choose Control Panel from the Settings entry.

 The Windows Control Panel appears:

 

2. Double-click the PixTools icon:
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 The PixTools/View control panel appears:

 

Controlling Accelerated Printing

The upper portion of the PixTools/View control panel controls accelerated printing. To
enable accelerated printing, you first must have a printer accelerator card installed in your
printer. Then, choose the printer for which you want to enable accelerated printing, and
click Set Accelerator. The following dialog appears:

Choose the printer accelerator from the list, and click OK.

 Important

 Printer acceleration varies according to the type of data sent to the printer
and the capabilities of the printer accelerator. Consult the documentation
supplied with your printer accelerator for specific information. If you
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experience problems with images printing incorrectly, you should disable
accelerated printing. Please contact PixTools Support department using
the contact information in Appendix C, supplying as much information
about the problem as possible

Controlling Accelerated Image Display

The lower portion of the PixTools/View control panel controls accelerated image display. If
you have an image display system capable of accelerated image display, the settings default
to enabled.

Normally, the enabled settings should work fine. However, if you experience problems with
image display quality, first try disabling “Use device-dependent bitmaps (DDB).” This
setting, when enabled, sends bitmap data to the display adapter using a bitmap format that
the display should understand. Disabling this setting sends device-independent bitmaps to
the display adapter. This may result in slower display performance.

If the display problem persists, disable “Use display accelerator.” Images are then sent to
the display adapter with no compression.

 Important

 If you experience any image quality problems when using accelerated
image display, please contact PixTools Support department using the
contact information in Appendix C, supplying as much information about
the problem as possible.

The “Number of pages to cache” lets you specify how many pages to store in memory. For
systems with 8 to 16 MB of memory, the default of 5 should provide good performance
without using too much memory.
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Appendix B  Other Pixel Translations
Products

Pixel Translations offers several toolkit products related to image acquisition and
management. These products are designed to allow programmers to easily integrate image
scanning, viewing, printing, and storage into their applications. PixView is an example of
the type of application that can be developed using these toolkits.

PixTools/Scan Universal scanner interface and driver toolkit

PixTools/Scan is a set of libraries that allow an application program to work with more than
90 different scanners from over 25 manufacturers. These libraries shield the application
developer from concerns about scanner type and capabilities, while providing scanning at
the full rated speed of the scanner.

PixTools/View High performance image viewing and printing toolkit

PixTools/View is an image management library that allows applications to easily provide
popular and important image viewing and printing capabilities such as zoom, pan, and
rotate. In addition, PixTools /View provides a variety of anti-aliasing techniques, including
scale-to-gray. Cornerstone display accelerators are supported transparently. Accelerated
printing is supported with the Fujitsu PrintPartner 10i and Xionics XIPPrint. PixTools /
View also supports full 24-bit color and 8-bit gray scale.

PixTools/View provides file import, export, and conversion libraries for standard image
files types (including TIFF, PCX/DCX, JPEG, CALS Type 1, and PDA, etc) and
compression types (uncompressed, Group 3, modified Group 3, Group 4, PackBits, JPEG,
and RLE, etc).
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PixTools/EZ  4GL ActiveX™ Control for Scanning, Viewing, and File I/O

PixTools/EZ is an ActiveX control that can be easily integrated into various fourth-
generation (4GL) programming environments, such as Microsoft Visual Basic, Borland
Delphi, PowerBuilder, and others. You can easily build a fully-functional image-enabled
application using drag-and-drop controls. All top-level functionality of PixTools/Scan and
PixTools/View is maintained, while an easy migration path is provided for developers who
need the low-level control provided only by PixTools/Scan and PixTools/View.
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Appendix C  Contacting Pixel Translations

Use the following information to contact Pixel Translations:

Pixel Translations
A Division of Input Software Inc.
1710 Fortune Drive, Suite 200
San Jose, CA  95131   USA

Telephone: (408) 325-3800
Fax: (408) 232-9292

Internet: www.pixtran.com
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Index

1
1:1 button, 39
1:1 command, 39

A
Add Scanner dialog, 23
adding annotations, 45
AddScan utility, 21
All Pages, 73
All Pages check box, 56
annotating pages, 45
annotation, 45

attributes, 49
moving, 46
tools, 47

annotation toolbar
enable/disable, 75

Annotation toolbar, 45
annotations

deleting, 46
resizing, 46

Annotations attributes popup menu, 49
Annotations menu, 46, 49, 54
annotations on a page image, 48
anti-aliasing (convert to gray scale), 44
Application settings command, 74
Application Settings dialog, 45, 74
auto resume scan, 75

B
Batch Detection list box, 35
batch separators, 34
BMP, 57
Brightness, 72, 74
Brightness (color), 74
button

1:1, 39
Fit Width, 38
Fit Window, 38
Next Page, 40
Prev Page, 40
Rotate, 39
Zoom In, 39
Zoom Out, 39

buttons, toolbar, 8

C
CALS, 58
Cancel Scan command, 32
cancel scanning, 32
Clipboard, copying to, 40
Color, 73
color format, 58
Color Model (color), 74
color support, 56
command

1:1, 39
Application settings, 74
Cancel Scan, 32
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Fit to width, 38
Fit to window, 38
Goto Page, 41
Next Page, 40
Open Document, 37
Page settings, 72
Previous Page, 40
Print (Actual Pixels), 52
Print (Actual Size), 52
Print (Fit Page), 52
Print Thumbnails, 52
Replace Page w/ New Orientation, 70
Rescan Page, 31
Rotate, 39
Save Document As, 54
Save Page As, 54
Scan Batch to File, 27, 33, 34
Scan page, 30
Scan Rotated Batch to File, 30
Show Thumbnails, 41, 42
Zoom in, 39
Zoom out, 39

compression options, 56
compression ratios, 56
Contrast, 72
Contrast (color), 74
control panel, accelerated printing and

display, 79
control panel, PixTools/View, 79
controlling accelerated display, 82
controlling accelerated printing, 81
convert to gray scale (anti-aliasing), 44
copy to Clipboard, 40
Copy to Clipboard question box, 40

D
DCX, 57
defining a custom naming schema, 65
deleting annotations, 46
Detect and Scan Separator, Continue

Scanning, 35

Detect and Scan Separator, Stop Scanning, 35
Detect and Skip Separator, Continue

Scanning, 35
Detect and Skip Separator, Stop Scanning, 35
disable accelerator, 75
disk space, 58
disk space required, 3
display

accelerated, control panel, 79
controlling acceleration, 82

display while scan, 75
displaying the Pan window, 41
Dither (color), 74
document

opening, 36
saving, 54

double-sided scanning, 32
double-sided scanning, and job separators, 35
duplex scanning, 32

E
editing naming schemas, 64

F
Factory Defaults, 73
file formats, 56
file name extensions, 56
File Naming Schema dialog, 64
finding pages, 40
Fit to width command, 38
Fit to window command, 38
Fit Width button, 38
Fit Window button, 38

G
getting started quickly, 5
go to, 40
Goto Page command, 41
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H
Horz Pres, 73

I
illustration

Add Scanner dialog, 23
Annotation toolbar, 45
Annotations attributes popup menu, 49
Annotations menu, 46, 49, 54
annotations on a page image, 48
Application Settings dialog, 45, 74
Copy to Clipboard question box, 40
File Naming Schema dialog, 64
Loading Driver Names progress monitor,

22
making a selection, 51
Name of Scanner dialog, 24
Open Document dialog, 37
Page Settings dialog, 72
Page Settings expanded dialog, 73
Pan window, 41
PixView icon, 25
PixView window, 6, 26
Prepare Scanner dialog, 29
Prepare Scanner dialog, 33, 34
Print dialog, 53
Print Setup dialog, 77
Print Thumbnail Setup dialog, 43, 52
Save As dialog, 55
Save Document Progress dialog, 56
ScaleToGray off versus on, 44
Scanned Document Name dialog, 27
Scanner Selection dialog, 7, 22
Scanner Settings dialog, 71
Selected area check box, 70
Thumbnail window, 43
Use Naming Schemas check box, 64

image file formats, 56
improving readability (anti-aliasing), 44
installation, quick, 5

installing additional scanner drivers, 21
installing PixView, 17

installing additional scanner drivers, 21
scanner installation, 17
selecting a scanner, 22

Instant Update, 73
Invert, 72

J
JBG, 57
job separators, 34
job separators, and double-sided scanning, 35
JPG, 57

K
keyboard shortcuts, 38, 39, 40

L
launching PixView, 25
Loading Driver Names progress monitor, 22

M
making a selection, 51
max 256 colors, 76
MDA, 58
Mirror, 72
mouse, and zooming, 39
Move As Group (color), 74
moving annotations, 46
moving around an image, 9

keyboard, 9
Pan window, 9
scroll bars, 9

multi-page support, 56

N
Name of Scanner dialog, 24
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naming schema
selecting, 64

naming schemas, 63
Next Page button, 40
Next Page command, 40

O
Open Document command, 37
Open Document dialog, 37
opening documents, 36
ordering additional scanner drivers, 4
orientation, 30, 70
other applications, using the Clipboard to

copy images, 40

P
page

saving, 54
page orientation, 30
Page Range check box, 56
page settings, 72
Page settings command, 72
Page Settings dialog, 72
Page Settings expanded dialog, 73
Pan window, 41
PCX, 57
PDA, 57
PDF, 58
PixName format in naming schemas, 65
PixName format strings, 66
PixTools/EZ, 84
PixTools/Scan, 83
PixTools/View, 83
PixTools/View control panel, 79
PixView

icon, 25
launching, 25
starting, 25

PixView visual index, 26
PixView window, 6, 26

placing annotations, 45
PNG, 58
Prepare Scanner dialog, 29, 33, 34
Prev Page button, 40
Previous Page command, 40
Print (Actual Pixels) command, 52
Print (Actual Size) command, 52
Print (Fit Page) command, 52
Print dialog, 53
Print Setup dialog, 77
Print Thumbnail Setup dialog, 43, 52
Print Thumbnails command, 52
printer settings, 77
Printf format in naming schemas, 65
Printf format strings, 67
printing, 51

accelerated, control panel, 79
controlling acceleration, 81

Q
quick start instructions, 5

R
reasons to open documents, 36
Replace Page w/ New Orientation command,

70
Rescan Page command, 31
rescanning a page, 31
resizing annotations, 46
rotate, 39
Rotate button, 39
Rotate command, 39
Rotation, 72
rules for schema entry, 68

S
Save As Defaults, 73
Save As dialog, 55
Save Document As command, 54
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Save Document Progress dialog, 56
Save Page As command, 54
saving pages and documents, 54
Scale to Gray, 72
ScaleToGray off versus on, 44
scaling, 38
Scaling, 72
Scan Batch to File command, 27, 33, 34
Scan page command, 30
Scan Rotated Batch to File command, 30
Scanned Document Name dialog, 27
scanner

drivers, obtaining, 4
installation, 17
interface methods, 18
selecting, 22
settings, 71

Scanner Selection dialog, 7, 22
Scanner Settings dialog, 71
scanning

a rotated batch, 30
a single page, 30
batches, 27
double-sided pages, 32
duplex, 32
pages, 26

schema
defining, 65
editing, 65
entry rules, 68
examples, 68
PixName format, 65
Printf format, 65

scroll bars, 41, 76
Selected area check box, 70
selecting

a naming schema, 64
a scanner, 22
an area to print, 51
files to open, 37

settings
page, 72

printer, 77
scanner, 71

setup, quick, 5
shortcut keys, 12, 38, 39, 40
Show Thumbnails command, 41, 42
single page scanning, 30
starting PixView, 25
system requirements, 3

T
table

shortcut keys, 12
Thumbnail window, 43
thumbnails, 42
TIF, 57
toolbar, 8, 38

annotation, 47
enable/disable, 75

toolbar text
enable/disable, 75

U
Use Current Orientation check box, 56, 63
Use Naming Schemas check box, 64
using annotations, 45

V
Vert Pres, 73
View as Gray (color), 74
viewing pages, 38

scaling, 38
zooming, 38

Viewing pages, 8

W
Warn on file overwrite check box, 28, 55
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Z
zoom factor, 76
Zoom In button, 39
Zoom in command, 39

Zoom Out button, 39
Zoom out command, 39
zoom, using the mouse, 39
zooming, 38
zooming tools, 38
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